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Глава 7  Синхронизация по дыханию

Система синхронизации по дыханию RPM использует движение 
стенки грудной клетки как индикатор смещения общего объема 
опухоли или других исследуемых частей тела, и, таким образом, 
как индикатор применения терапии.

Р а б о ч и й  п р о ц е с с  с и н х р о н и з а ц и и  п о  д ы х а н и ю  
и  и с т о ч н и к и  и н ф о р м а ц и и

Ф
В Табл. 34 приведены задачи рабочего процесса синхронизации 
по дыханию и источники инструкций.

Табл. 34 Рабочий процесс синхронизации по дыханию

Задача Иистр^^кции

Определить, является 
ли синхронизация по 
дыханию подходящим 
индикатором проведения 
терапии для состояния 
пациента и области 
применения терапевти­
ческого воздействия.

«Определение возмож 
ности применения синхро 
низации по дыханию для 
проведения терапии» 
на стр. 196

Включить синхронизацию 
и запустить программное 
обеспечение синхрониза­
ции по дыханию.

«Этап 1. Запуск оборудо­
вания и ПО синхрони­
зации по дыханию» 
на стр. 197

Выбрать пациента и полу­
чить контрольные данные 
для синхронизированной 
визуализации или прове 
дения терапии.

«Этап 2. Выбор пациента и 
открытие сеанса для синх 
ронизированной визуали 
зации или проведения 
терапии» на стр. 198
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Табл. 34 Рабочий процесс синхронизации по дыханию (продолжение)

1 Задача Инструкции 1

Подготовить оборудование 
RPM и пациента в 
процедурной.

«Этап 3, Настройка 
оборудования RPM и 
подготовка пациента в 
процедурной» на стр. 199

Разместить блок 
маркеров на пациенте.

См. Огравочное руководство 
по системе синхронизаг^ии 
по дыханию RPM.

Следить за оборудова 
нием и пациентом.

«Мониторинг оборудова 
ния и пациента» на стр. 200

Записать контрольные 
данные.

«Запись контрольных 
данных симуляции» 
на стр. 201

Использовать методику 
задержки дыхания для 
записи контрольных 
данных.

«Использование задержки 
дыхания в сеансах проспек 
тивной КТ-симуляции» 
на стр.207

Записать первый сеанс 
задержки дыхания, чтобы 
откорректировать в соот 
ветствии с контрольными 
данными.

«Запись первого сеанса с 
задержкой дыхания» 
на стр.209

Проследить за дыханием 
и получить синхронизи 
рованные изображения.

«Отслеживание дыхания и 
получение синхронизиро 
ванных изображений» 
на стр. 211

Экспортировать данные 
движений.

«Экспорт данных синхро 
низации по дыханию» 
на стр. 215.

Провести синхронизиро 
ванную терапию.

«Проведение терапии» 
на стр. 217
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о  р а б о ч е й  о б л а с т и  с и н х р о н и з а ц и и

В окне программы системы синхронизации по дыханию RPM 
содержатся строка заголовка с именем текущего пациента 
и сеансом терапии, строка меню, панели инструментов и несколько 
областей отображения.

Примечание. В этом окне нет возможности прокрутки. Как правило,
I данное окно разворачивают на весь экран.
I Полное описание меню данного приложения см. в Справочном
I руководстве по системе синхронизации по дыханию RPM.

О бласти отображ ения RPM

Б окне синхронизации по дыханию RPM содержится несколько 
I областей отображения.

■ В области изображения отображаются видеоизображения 
с камеры либо рентгеноскопа.

ш В области панели сеанса отображаются сведения о сеансе 
I и кнопки для задания параметров сеанса или закрытия сеанса

пациента.
I ■ В области графика отображаются соответствующая фаза цикла
! дыхания на круговом графике и движение на динамической

диаграмме.
■ В правом верхнем углу главного окна в определенные моменты

1 времени, например во время записи, появляются визуальные
подсказки.
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Задачи и кнопки RPM

Кнопки панели инструментов вызывают выполнение функций 
для текущего открытого сеанса пациента. Доступные для 
выполнения задачи и используемые кнопки описываются в 
Табл. 35.

Табл. 35 Задачи и кнопки синхронизации 
по дыханию RPM

1 Чтобы выполнить эту задачу Выберите
Открыть в окне изображения видео с камеры 
слежения в режиме реального времени.

Camera (Камера)

Отобразить видео с рентгеноскопа в режиме 
реального времени в ходе рентгеноскопической 
симуляции.
(Эта функция доступна, если рабочая 
станция сконфигурирована для 
рентгеноскопической симуляции.)

Fluoro
(Рентгеноскопия)

Отобразить видео в ходе виртуальной 
симуляции или терапии.
(Эта функция доступна, если рабочая 
станция сконфигурирована для виртуальной 
симуляции или терапии.)

2nd Video Ch 
(2-й видеоканал)

Начать видеоотслеживание и определение 
границ дыхательного движения пациента. 
Отменить запуск КТ-сканирования при 
получении изображений в ходе виртуальной 
симуляции, (Переключаемая кнопка.)

Track (Отследить)

С помощью встроенной функции 
визуализации проверить планируемую 
синхронизацию перед терапией.

Verify
(Проверить)

Запустить сеанс терапии из сеанса 
планирования.

Treat (Терапия)

Начать запись движения и видео. Record (Запись)
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Табл. 35 Задачи и кнопки синхронизации
по дыханию RPM (продолжение)

Чтобы выполнит эту задачу Выберите
Автоматически начать запись или слежение 
через 4-1/2 цикла дыхания.

Пункт Auto Start 
Of Session 
Recording 
(Автоматический 
запуск записи 
сеанса) в диалого­
вом окне Options 
(Параметры). 
Затем нажмите 
кнопку Record 
(Запись) или Track 
(Отследить).

Остановить запись, воспроизведение или 
синхронизированную терапию.

Stop (Остановить)

Временно приостановить запись, воспроизве­
дение или синхронизированную терапию.

Pause (Пауза)

Запустить синхронизированное 
воспроизведение движения и видео.

Playback
(Воспроизвести)

Сохранить последние записанные данные 
Б файл.

Save (Сохранить)

Отключить синхронизацию в режиме терапии. 
Отменить запуск КТ-сканирования при 
получении данных симуляции.

Stop Gating
(Остановить
синхронизацию)

Разрешить синхронизированЕ1ую лучевую 
терапию в режиме терапии.
Разрешить автоматический запуск КТ-сканера 
при получении данных симуляции.

Enable Gating
(Разрешить
синхронизацию)

Примечание. У ПК рабочей станции есть два видеовхода.Один всегда 
подключен к камере слежения, и его кнопка помечена как Camera 
(Камера). Метка второго входа зависит от установки.
ш Если рабочая станция установлена в кабинете с КТ-симулятором 

или 6 процедурной, то другой видеовход также подключен к камере 
слежения и кнопка для управления вторым видеоканалом называется 
2nd Video Ch (2-й видеоканал), 

ш Если рабочая станция установлена в кабинете с рентгеноскопи­
ческим симулятором, то второй видеовход подключен к рентгенос- 
копу, а кнопка для управления вторым видеоканалом называется 
Fluoro (Рентгеноскопия).
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О п р е д е л е н и е  в о з м о ж н о с т и  п р и м е н е н и я  
с и н х р о н и з а ц и и  п о  д ы х а н и ю  д л я  п р о в е д е н и я  
т е р а п и и

Система синхронизации по дыханию RPM предназначена для 
лечения образований или других анатомических структур, 
непосредственно затрагивающих дыхательное движение, 
в особенности в грудной клетке и верхнем отделе брюшной 
полости. Дыхательный процесс также может захватывать 
следующие области:
■ Легкие, грудные железы, пищевод, печень и поджелудочная 

железа;
■ Нижний отдел брюшной полости или таз, если у пациента 

наблюдается значительное движение диафрагмы во время 
дыхательного цикла (диафрагмальный тип дыхания).

ВНИМАНИЕ! Ответственность за определение пригодности 
дыхательного движения в качестве индикатора для терапии при 
любых конкретных состояниях пациента или настройках 
параметров подготовки пациента лежит целиком и полностью на 
квалифицированном медицинском персонале. Это определение 
должно быть основано на клинической оценке с использованием 
рентгеноскопической или иной визуализации, подходящей 
в каждом конкретном случае.

Квалифицированный медицинский персонал, работающий с этим 
оборудованием, по своему выбору использует при лечении метод 
дыхательного движения в следующих случаях:
■ области, не затрагиваемые дыхательным движением, такие как 

голова, конечности или неподвижные костные структуры,
для которых эта система обычно не предназначена;

■ состояния пациентов, в которых применение системы может 
быть ограничено, например, дисфункция легких, когда при 
дыхании стенки грудной клетки движутся незначительно либо 
не движутся вовсе, или чрезмерная нерегулярность 
дыхательного цикла, препятствующая точному определению 
повторяющегося интервала синхронизации.
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Запуск оборудования и ПО RPM

Предпосылки использования системы синхронизации 
по дыханию RPM

■ Запустить оборудование и п рограм м н ое обеспечение системы 
си н хрон и зац и и  по ды ханию  RPM.

■ В ыбрать п ац иента и откры ть сеанс для си н хрони зи рован ной  
в и зу ал и зац и и  и п роведения терапи и .

■ Н астрои ть оборудование RPM  и подготовить п ац иента 
в процедурн ой .

• Выполнение предпосылок для получения
синхронизированных изображений и записи данных 
о дыхании

Этап 1. Запуск оборудования и ПО синхронизации по дыханию

1. П р и  необходим ости  вклю чите рабочую  станцию  RPM.

2 . П оверните клавиш ны й переклю чатель на коробке 
п ереклю чателей  си н хрони зац и и  в п о ло ж ен и е G A T IN G  
E N A B L E D  (С И Н Х РО Н И ЗА Ц И Я  РАЗРЕШ ЕНА).

3. Войдите в операционную  систему W indow s ХР или  W indow s 2000 
на рабочей  станции  RPM, указав свое и м я пользователя
и  п ароль.

4. В ы берите в меню  W indow s Start (Пуск) следую щ ие пункты: 
Program s (П рограм м ы ) > Varian Respiratory G ating 1.7 >
RPM  R espiratory G ating  1.7.
О ткры ваю тся окно си н хрони зац и и  по  ды ханию  RPM  

^1^ и  диалоговое окно Patien t List (С писок пациентов).

5. П роверьте, что путь, о тоб раж аем ы й  в строке заголовке окна 
си н х р о н и зац и и  по  ды ханию  RPM, п равилен  и  указы вает на 
п ап ку  с клиническим и, а не исследовательским и дан ны м и  — 
н ап р и м ер , S : \P a t i e n t s D a ta .

6 . Если указана н еп равильн ая п ап ка  базы  данных, то  вы полните 
следую щ ую  п роцедуру, «И справление вы бора п ап ки  базы  
данных».
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Исправление выбора папки базы данных

1 . Если п ап ка  базы  данны х отображ ается  неправильно, наж м ите 
кнопку Close (Закрыть).

2. В меню  View (Вид) щ елкните System  C onfiguration
(К он ф игураци я системы).

3. Н а вкладке G eneral (О бщ ие) диалогового окна System 
Configuration (К он ф игураци я системы) н аж м и те  первую  
кнопку  Browse (О бзор).

4. В диалоговом  окне D atabase Location (М естополож ение базы  
данных) вы берите п равильн ы й  ф ай л  базы  данны х и  н аж м и те 
кнопку O pen (Открыть). Н аж м и те кнопку О К  в сообщ ени и
о выходе из системы, чтобы  изм ен ен и е вступило в силу.

5. Б диалоговом  окне System  C onfiguration  (К он ф игураци я 
системы) н аж м и те  кнопку О К .

6. В ы берите File > Exit (Ф айл > Выход).

7. П овторите процедуру, начиная с эт. 3 раздела «Этап 1. Запуск 
оборудования и П О  си н хрони зац и и  по  дыханию » на стр. 197.

Этап 2. Выбор пациента и открытие сеанса для 
синхронизированной визуализации или проведения терапии

1. Н а рабочей  станции  вы берите File > Select P atien t (Ф айл > 
В ыбрать пациента), чтобы  откры ть диалоговое окно Patients 
List (С писок пациентов).

2 . В ы полните одно и з описанны х н и ж е действий.
□ В ы берите и м я  пациента, а затем  н аж м и те  кнопку Select 

(Выбрать).

□ Н аж м и те  кнопку N ew  Patien t (Создать пациента), введите 
данны е, а затем  н аж м и те  кнопку О К .
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3. С оздайте сеанс одним  из указанны х н и ж е способов.
□ В ы берите п оле и ли  ти п  названия п о ля  в диалоговом  окне 

New Treatment Field (С оздание п оля  тер ап и и ) и  н аж м и те  
кнопку О К .

□ Щ елкните A dd New Field (Д обавить новое поле)
в диалоговом  окне Treatment Fields and Sessions (П оля 
и сеансы терапи и ), а затем н аж м и те  кнопку О К .

□ В ы берите сущ ествую щ ий сеанс для п о ля  в диалоговом  
окне Treatment Fields and Sessions (П оля и сеансы терапи и ) 
и н аж м и те кнопку D elete Session (У далить сеанс), чтобы 
удалить сеанс. Щ елкните A dd N ew  Field (Д обавить 
новое поле), вы берите п оле и л и  введите название п о ля
в диалоговом  окне New Treatment Field (С оздание п о ля  
терапи и ), а затем  н аж м ите кнопку О К .

Этап 3. Настройка оборудования RPN1 и подготовка пациента 
в процедурной

1 . Запустите систему си н хрони зац и и  по  ды ханию  RPM, 
ин стр у кц и и  см. в разделе «Запуск оборудования и  П О  RPM» 
на стр. 197.

2 . П ерем естите куш етку в п о ло ж ен и е первого среза.

3. Р азм естите п ациента на куш етке.

4. Разм естите блок м аркеров на пациенте.

5. П одготовьте устройство визуализации .

6 . П о м ере необходим ости  получите ориентировочное 
и зо б р аж ен и е  и ли  вы полните другие задачи, предусм отренны е 
д ля  начала исследования.

7. В ы берите один  и з вариантов.
□ Д ля  п лан ирован и я тер ап и и  зап и ш и те контрольны е 

данны е си м уляц и и , и нструкц ии  см. в разделе «Запись 
контрольны х данных си м уляц и и»  на стр. 2 0 1 .

□ О  п роверке п лан и р у ем о й  т ер ап и и  см. в разделе «П роверка 
данны х ды хания и си н хрони зац и и  и получение 
синхронизированны х и зображ ен и й»  на стр. 2 1 1 .

□ О  п роведении  синхрони зи рован ной  т ер ап и и  см. в разделе 
«П роведение тер ап и и  с си н хрони зац и ей  по  дыханию »
на стр. 254.
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Мониторинг оборудования и пациента

ж

ВНИМАНИЕ! Когда во время записи используется автоматический 
запуск КТ-сканера, по соображениям безопасности необходимо 
постоянно следить за экраном системы RPM.
Если отключается питание рабочей станции RPM или система 
перестает отвечать на команды, немедленно вручную остановите 
КТ-сканирование с помощью стандартных процедур для КТ-сканера. 
Если в результате отключения питания контур системы RPM, 
передающий сигнал запуска, остается в замкнутом положении, 
КТ-сканер может продолжать выполнять нежелательное сканирование 
в неправильных состояниях дыхания. В результате для планирования 
создаются неправильные КТ-и зоб раже ния. Планирование терапии 
на основе ошибочных КТ>изображений может привести к 
неправильному лечению.

П р и  и сп ользован и и  системы  RPM  следуйте приведенны м  н иж е 
указан иям .
■ Если отклю чается п итани е рабочей  станции  RPM  и л и  система 

перестает отвечать на команды^ немедленно вручную остановите 
К Т -сканирование с пом ощ ью  стандартны х п р о ц ед у р  для 
КТ-сканера.

■ Если дыхание пациента становится нестабильным, то КТ-система 
мож ет приостановить работу до восстановления периодичности. 
Б этом  случае следует перезапустить  последовательность 
сканирования согласно п рин яты м  в отделен и и  п равилам .

■ Если п ер ем ещ ен и е п ац и ен та  сущ ественно и зм ен яет  кривую  
диаграммы ^ система п р екр ащ ает  подачу сигналов запуска^ 
даж е после восстановления периодичности . Н а кривую  
диаграм м ы  м ож ет влиять изм енение п о л о ж ен и я  п ац иента 
и л и  блока маркеров.

П риостановка сканирования м ож ет потребоваться, если  
ды хание п ац и ен та  п р и о б р етает  н ерегулярны й  характер  и ли  
изм еняется п о ло ж ен и е блока м аркеров. С ледуйте инструк­
ц и ям  в разделе «П риостановка сканирования в течение интер  
вала си н хрони зац и и»  на стр. 214. Р еш ение о п р о д о л ж ен и и  
сеанса, если  п ац и ен т  не м ож ет восстановить ретулярны й  
характер  ды хания за разум ное время, является клиническим  
реш ением .
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Запись контрольных данных симуляции

П еред вы полнением  синхронизированной  в и зу ал и зац и и  и ли  
п роведением  син хрони зи рован ной  тер ап и и  соответствую щ ий 
м еди ц и н ски й  п ерсонал  д олж ен  получить контрольны е данны е 
в сим ули руем ом  сеансе си н хрон и зац и и  по  ды ханию . П ерсонал 
вы п олн яет указанны е н иж е действия.
1 . Если систем а си н хрони зац и и  по  ды ханию  RPM  подклю чена 

к систем е ви зуали зац и и  КТ и л и  ПЭТ, зап и ш и те  ды хательны е 
движ ения пациента и другае данные во время сеанса симуляции.
В зависим ости  от н астрой ки  лечебное учреж ден и е обы чно 
п олучает данны е си м уляц и и , и спользуя один  и з методов, 
приведенны х в Табл. 36.

Табл. 36 Методы получения контрольных данных
синхронизации

ЙЯетод СИНХ 
ронизации

Записи КТ“ или 
ПЭТ -сканирования Инструкции

Ретроспектив
ны й

Весь сеанс без синхрони 
зац и и , н ап р и м ер , чтобы  
показать степень см ещ е 
н ия органа.

«Запись ретрос 
пективны х дан 
ных» на стр. 2 0 2 .

П роспектив
ны й

О дно место в анатом ичес 
кой области, когда п о лу ­
чение данных вклю чено.

«Запись и  п ро  
спективная синх­
р о н и зац и я  
К Т-данных сим у­
л яц и и »  на 
стр. 206.

Задерж ка
ды хания

С канирование и н и ц и и  
руется п ериодическим  
и регулярны м  ды ханием  
пациента.

«И спользование 
зад ерж ки  дыха 
н ия в сеансах п ро  
спективной

2.

К Т -сим уляции» 
на с т р .207

П осле зап и си  данных зап лан и руй те  сеанс тер ап и и , настраивая 
интервал  си н хрон и зац и и  в контрольном  сеансе, чтобы  
ком пенсировать задерж ку  м еж ду запуском  и получением  
и зображ ен и я.
Д ополн ительн ы е сведения см. в Гл. 4, «П ланирование 
п роведения терапи и » .
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■ КТ- и л и  П Э Т-сканер настроен для скан ирован и я по  оси 
с автом атическим  внеш ним  запуском.

■ Все дополн и тельн ы е ф ун кц ии  настройки  КТ- и ли  
П ЭТ-системы  активированы .

■ О борудование и П О  RPM запущ ены, см. раздел «Этап 1 . Запуск 
оборудования и П О  си н хрони зац и и  по  дыханию » на стр. 197.

■ П лан  п ац и ен та  не загруж ен, если  п ланируется использовать 
м етод задерж ки  ды хания,

■ П лан пациента загружен, для ретроспективной и  проспективной 
си н хрони зац и и , и нструкц ии  см. в разделе «Этап 2. Выбор 
п ац и ен та  и  откры тие сеанса д ля  син хрони зи рован ной  
в и зу ал и зац и и  и л и  проведения терапи и »  на стр. 198.

■ О борудование RPM  настроено, а п ац и ен т  подготовлен
в п роцедурн ой . И н струкци и  см. в разделе «Этап 3. Н астройка 
оборудования RPM  и  подготовка п ац иента в процедурн ой »  
на стр. 199.

Запись ретроспективных данных

п р о ц е д у р ы  зап и си  ретроспективны х и  проспективны х данных 
аналогичны . О днако ретроспективны е данны е записы ваю тся 
н еп реры вн о  без син хрони зац и и , а для зап и си  проспективны х 
данны х используется синхронизация.

П р и  п лан и р о ван и и  т ер ап и и  для деления ц и к ла  ды хания 
в систем е си н хрон и зац и и  по  ды ханию  RPM  используется 
врем енная последовательность. Затем  эти  данны е использую тся 
п р и  п лан ирован и и .

Предпосылки записи ретроспективных данных

■ Н астройте автоматическую остановку запуска КТ, когда система 
в и зу ал и зац и и  не запускается о ж и даем ы м  о б разом  и ли  
н еож и дан но  останавливается.

■ Убедитесь, что д л я  интервала си н хрони зац и и , определенного  
на рабочей  станции  восстановления и зображ ен и я, задано 
значение Phase (для си н хрони зац и и  по  фазе).

■ Н астрой те другие п арам етры  си н хрони зац и и  д ля  лечебного 
у ч реж д ен и я и л и  пациента.

Предпосылки записи данных симуляции
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Выполнение предпосылок для записи ретроспективных данных

1. В ы берите View > System  C onfiguration (Вид > К он ф и гурац и я 
системы).

2. Щ елкните вкладку СТ Triggering (Запуск КТ).

3. (Н еобязательно) Ч тобы  гарантировать остановку записи , когда 
систем а ви зуали зац и и  не запускается о ж и д аем ы м  образом  
и л и  н еож и дан но  останавливается, щ елкните стрелки  вверх 
и л и  вниз п од  м еткой  Stop Recording If (О становить запись, 
если). Затем  исправьте количество се к )^ д  для следую щ их 
парам етров:
D N o First Pulse A fter (Отсутствие первого им п ульса после)
□ N o  N ew  Pulse A fter (Отсутствие нового и м п ульса после)

4. Н аж м и те  кнопку ОК. В ы берите View > Session O ptions 
(Вид > П арам етры  сеанса).

Д иалоговое окно Session O ptions (П арам етры  сеанса) 
откры вается на вкладке G ating (С инхронизация).

5. В области  Phase (Фаза) убедитесь, что для п ар ам етр а  G ate On 
A m p litu d e  (С и нхрон и зац ия по  ам плитуде) вы брано значение 
Phase (Фаза).

6 . П р и  необходим ости  настройте значения на вкладках A udio  
(А удио) и  V isual P ro m p t (Визуальная подсказка) диалогового 
окна Session O ptions (П арам етры  сеанса). Н астрой те все 
остальны е п арам етры , у п р авл яю щ и е записью , в соответствии 
с п р о то ко л ам и  у чреж ден и я или , если  это  требуется, 
сп ец и альн ы м и  и н струкц и ям и  для пациента.

7. Н аж м и те  кнопку О К.
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1. Н а п ан ели  сеанса RPM  щ елкните Track (Отследить),

2 . П одож дите, пока система о п р ед ел и т  д и ап азо н  ды хательного 
д ви ж ен и я п ациента. С ледите за строкой  синих квадратов в 
левой  верхней области  и зо бр аж ен и я  и  цветом  кн оп ки  Record 
(Запись). Н есколько синих квадратов и черная кнопка Record 
(Запись) означаю т, что ды хание достаточно регулярно, чтобы  
систем а могла записать данные.

3. П рои н структи руй те п ац иента о том , как будет проходить 
п р о ц еду р а  и что ем у следует делать, н ап р и м ер , слуш ать 
голосовые инструкции  и следить за визуальны ми подсказками, 
чтобы  поддерж ивать  регулярность дыхания.

4. В ы берите один  из вариантов.
□ Р азреш и те  системе начать запись автоматически.

□ Н аж м и те  кнопку R ecord  (Запись). Р азреш и те  п ро до л ж и ть  
запись и сканирование согласно сухцествующему
в учр еж д ен и и  п р отоколу  и л и  инструкц иям  для данного 
пациента.

5. В ы полните одно и з описанны х н и ж е действий.
□ Ч тобы  закончить запись проспективны х контрольны х 

данных, перей дите к разделу  «Запись и проспективная 
си н хрони зац и я КТ-данных си м уляц и и»  на стр. 206.

□ Ч тобы  закончить запись ретроспективны х контрольны х 
данных, когда запись окаж ется достаточно длинной , 
н аж м и те кнопку S top  (Остановить).

6 . П р о см о тр и те  запись, инструкц ии  см. в разделе «П росм отр 
записанны х данны х си м уляц и и»  на стр. 205.

Запись ретроспективных данных симуляции
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Записанны е данные сим уляции, ретроспективные, проспективны е 
и л и  для зад ер ж ки  ды хания, необходим о просм отреть.

1 . П р о см о тр и те  записанны е данны е си м уляц и и .

2 . Затем  вы берите нуж ны й вариант.

Просмотр записанных данных симуляции

Если вы принимаете 
решение.. .

Зам ен ить  неудовлетво 
рительную  запись

Тогда

1. Н аж м и те  кнопку Track 
(Отследить), а затем  — Yes (Да), 
чтобы  сохранить данны е как 
новый сеанс.

2 . П овторите п роцедуру , начиная 
с эт. 3, чтобы  п овторн о  записать 
сим улированны е данны е.

С охранить данны е 1.

2.

В ы берите File > Save (Ф айл > 
Сохранить), чтобы  сохранить 
данные.

В ы берите ком анду Close Patient 
(Закры ть п ац иента) на панели  
Session (Сеанс).

Теперь сеанс готов к планированию . 
Д ополнительны е сведения см. в 
разделе «П ланирование 
проведения терап и и »  на стр. 57.

Э кспортировать  данны е См, раздел  «Э кспорт данны х синх­
р о н и зац и и  по  дыханию » на 
стр. 215.
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П роц едуры  зап и си  ретроспективны х и проспективны х данных 
аналогичны . П роспективны е данны е синхронизирую тся п р и  
зап и си , ретроспективны е данны е записы ваю тся непреры вно, 
без си н хронизации .

1. Н а  п ан ел и  сеанса RPM щ елкните Track (О тследить).

2 . П одож дите, пока систем а о п р ед ел и т  д и ап азо н  дыхательного 
д ви ж ен и я пациента. С ледите за строкой  синих квадратов
в левой  верхней области  и зо бр аж ен и я  и  цветом  кнопки  
Record (Запись). Н есколько синих квадратов и черная кнопка 
Record (Запись) означаю т, что ды хание достаточно регулярно, 
чтобы  систем а могла записать данные.

3. П рои н структи руй те п ац иента о том , как будет проходить 
п р о ц еду р а и что ем у  следует делать, н ап р и м ер , слуш ать 
голосовые инструкции и следить за визуальны ми подсказками, 
чтобы  поддерж ивать  регулярность дыхания.

4. В ы берите один  из вариантов.
□ Разрегиите системе начать запись автоматически.
□ Н аж м и те  кнопку Record (Запись). Р азреш и те  п р о до л ж и ть  

запись и  сканирование согласно сущ ествую гцему в 
учр еж д ен и и  п р отоколу  и л и  инструкц иям  д ля  данного 
пациента.

5. Н а п ан ел и  инструментов RPM  гцелкните Enable G ating 
(Вклю чить синхронизацию ).

6 . Д ождитесь, когда дыхательное движ ение окаж ется за границей  
выхода и з интервала си н хрони зац и и , и н аж м и те  кнопку 
запуска сканера.

Э тот подход позволяет и збеж ать запуска сканирования внутри 
и нтервала си н хронизации .

7. Р азреш и те п ро до л ж и ть  запись и  сканирование согласно 
сущ ествую гцему в учреж д ен и и  протоколу  и ли  и нструкц иям  
для данного пациента.

8 . Если н аруш ени е регулярности  ды хания приведет к остановке 
КТ- и л и  П ЭТ-системы и л и  блок м аркеров см естится на 
пац иенте , вы полните указанны е н и ж е действия.
a. С ледуйте инструкц иям  в разделе «П риостановка 

сканирования в течение интервала си нхронизации»  
на стр. 214.

b . В озобновите синхронизированную  запись (см. этап  2).

Запись и проспективная синхронизация КТ-данных симуляции
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9. П осле получения достаточного числа сканирований  
дож дитесь, когда ды хательное дви ж ени е вы йдет за границы  
и нтервала си н хрони зац и и , и  н аж м и те  кнопку S top  G a tin g  
(О становить синхронизацию ).

Э тот подход позволяет избеж ать остановки сканирования 
внутри  интервала синхронизации .

10. Н аж м и те  кнопку S top  (Остановить).

11. П р осм отри те запись, инструкц ии  см. в разделе «П росм отр 
записанны х данны х си м уляц и и»  на стр. 205.

Использование задержки дыхания в сеансах проспективной 
КТ-симуляции

Когда система синхронизации по дыханию RPM подключена 
к КТ-сканеру с функцией автоматического запуска, можно 
использовать вариант интервала синхронизации по задержке 
дыхания.

Предпосылки использования задержки дыхания при записи 
проспективных данных КТ-симуляции

■ В ы полнены  предпосы лки , описанны е в разделе 
«П редпосы лки  зап и си  данны х си м уляц и и»  на стр. 202.

■ П лан  п ац и ен та  не загруж ен.
■ Д ля сеанса выбран ти п  зад ерж ки  ды хания и заданы  другие 

п ар ам етр ы  си н хрон и зац и и  для лечебного учреж д ен и я
и п ациента.

Выполнение предпосылок для использования синхронизации 
по задержке дыхания при записи проспективных данных

1 . П р и  необходим ости  запустите система си н хрон и зац и и  по 
ды ханию  RPM, инструкц ии  см. в разделе «Этап 1. Запуск 
оборудован и я и  П О  си н хрони зац и и  по  дыханию » на стр. 197.

2 . Убедитесь, что сеанс не загруж ен. (Если RPM  уж е запущ ена
и сеанс загруж ен, щ елкните C lose P a tien t (Закры ть пациента), 
чтобы  выгрузить сеанс.)
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3. В ы берите View > Session Options (Вид > П арам етры  сеанса).

Д иалоговое окно Session Options (П арам етры  сеанса) 
откры вается на вкладке Gating (С инхронизация).

4. Для п ар ам етр а  B reathing Туре (Тип ды хания) значение 
Breath-hold (Задерж ка дыхания).

5. П осле и зм енения ти п а  ды хания с Periodic (П ериодический) 
на Breath-hold (Задерж ка ды хания) в ответ на п р и гл аш ен и е 
задать д ля  парам етров  сеанса значения по  ум олчан ию  
н аж м и те  кнопку Yes (Да).

6 . П р и  необходим ости  настройте значения на вкладках Gating 
(С инхронизация), Audio (Аудио) и Visual Prompt (Визуальная 
подсказка) диалогового окна Session Options (П араметры  сеанса).

^ 1̂  7. Н аж м и те  кнопку О К.

8. В ы берите View > System Configuration (Вид > К онф игурац и я 
системы).

9. В диалоговом  окне System Configuration (К он ф игураци я 
системы ) вы берите вкладку File Export (Э кспорт ф айлов).

10. Если п еред  экспортом  данны х о ды хании  установлен ф л аж о к  
Recalculate Phase (П овторно рассчитать фазу), удалите его.

Примечание. Если сеанс не загружен, измененные значения параметров 
сеанса применяются ко всем последующим контрольным сеансам. 
Чтобы переключить будущие контрольные сеансы на периодическое 
дыхание, при незагруженном сеансе измените значение параметра 
Breathing Туре (Тип дыхания) обратно на Periodic (Периодическое). 
Также установите флажок Phase Recalculation (Повторно рассчитать 
фазу). Эти изменения будут, применены к последующим контрольным 
сеансам и ?1роизводным otn них курсам терапии.

11. Щ елкните вкладку Chart (График). П р и  необходимости удалите 
ф л аж о к  Auto Scale (А втоматическое м асш табирование).

12. Н аж м и те  кнопку ОК.
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Запись первого сеанса с задержкой дыхания

П ервая запись является п р о бн о й  п р о ц еду р о й  для п ациента, 
чтобы  пом очь п ац иенту  освоить м етодику зад ерж ки  ды хания 
и установить пороги . Н а основе первой  зап и си  отвечаю щ ий за 
п лан и рован и е персонал  устанавливает п ороги  для уровня 
зад ер ж ки  ды хания, не доставляю щ ие диско м ф о р та  пациенту.

1 . П оп р о си те  п ац и ен та расслабиться.

2 . Дайте п ац иенту  конкретны е и нструкц ии  по  задерж ке ды хания 
в зависим ости  от вы бранного ти п а  задерж ки .
□ Д ля  глубокого вдоха
a. С делайте выдох
b . С делайте вдох более глубокий, чем обычно. Глубина вдоха 

п ац и ен та  долж на превосходить глубину вдоха, с которой  
п ац и ен т  обы чно ды ш ит.

c. Задер ж и те ды хание
□ Д л я  обы чного вдоха
a. С делайте выдох.
b . С делайте вдох.
c. Задер ж и те дыхание.

3. П овторите эт. 2 несколько р аз для трен и ровки  м етодики
и  оп ред елен и я о п ти м альн ой  п родолж и тельн ости  зад ер ж ки  
ды хания согласно исп ользуем ом у протоколу. П осле каж дой  
зад ер ж ки  ды хания п роси те п ац и ен та  расслабиться и  ды ш ать 
в н орм альном  тем пе.

4. Щ елкните S top (Остановить) на пан ели  инструментов.

5. П оп роси те п ац иента расслабиться и ды ш ать в норм альном  
тем пе.

6 . С п о м о щ ью  стрелок вверх и вниз в области  граф ика 
отрегули руйте ш калу  вручную, чтобы  уровни  ды хания п р и  
н орм альном  тем пе и задерж ке бы ли  отчетливо видны  на 
граф ике.

7. П роверьте д и агр ам м у  и  записи  трен и ровки  задерж ки  
ды хания и  вы берите уровень зад ерж ки  ды хания д ля  пациента.
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8 . П еретащ ите две ам плитудны е л и н и и  порога чуть выш е и чуть 
н и ж е вы бранного уровня задерж ки  ды хания, раздели в  их 
интервалом  допускаем ого д ви ж ени я во врем я задерж ки  
ды хания, н ап р и м ер , 0,5 см. См. Рис. 13 и Рис. 14.

Рис. 13 Выбор нижнего порога

А. Плато задержки дыхания В. Точка входа 

Рис. 14 Перемещение нижнего порога

9. Выберите продолжительность спирального КТ- или
П Э Т -сканирования на основании наблю даем ы х показателей  
п ац иента , выявленны х во врем я п робн ой  п роцедуры , 
и  зап р о гр ам м и р у й те  сканер соответствую щ им образом .
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Проверка данных дыхания и синхронизации 
и получение синхронизированных изображений

Когда заданы  пороги  для уровня зад ерж ки  ды хания, 
поддерж иваем ого  в п робн ой  процедуре, и сп ланирована 
тер ап и я , все готово для п роверки  данны х си м у л яц и и  путем  
п олучения синхронизированны х и зо бр аж ен и й . В ы полните этот 
этап  п еред  проведением  тер ап и и  и  п р и  необходим ости  настройте 
синхронизацию .

Предпосылки записи данных о дыхании и получения 
синхронизированных изображений

■ К онтрольны е данны е получены  во врем я сеанса си м уляц и и .
■ В ы полнены  п редпосы лки  использования системы  синхрони­

зац и и  п о  ды ханию  RPM, инструкц ии  см. в разделе «Запуск 
оборудования и П О  RPM» на стр. 197.

Отслеживание дыхания и получение синхронизированных 
изображений

1 . Если отслеж ивание нового поля терапи и  не началось, то на­
ж м ите кнопку Track (Отследить) на панели инструментов RPM.

2 . П одож дите, пока систем а о п ред ели т д и ап азо н  дыхательного 
дви ж ени я пациента. С ледите за строкой синих квадратов
в левой  верхней области  и зо бр аж ен и я  и цветом  кнопки  Record 
(Запись). О т одного до четы рех синих квадратов и  черная 
кнопка Record (Запись) означаю т, что ды хание достаточно 
регулярн о  для зап и си  данных.

3. П рои н структи руй те п ац иента о том , как будет проходить 
п р о ц ед у р а  и что ем у следует делать, н ап р и м ер , слуш ать 
голосовые инструкции  и  следить за визуальны ми подсказками, 
чтобы  поддерж ивать  регулярность дыхания.
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4. В ы берите один  из описанны х н и ж е вариантов.
□ Н аж м и те  кнопку Record (Запись). О твечаю щ ий за 

п лан и рован и е персонал  долж ен  отрегулировать пороги  
и нтервала си н хронизации .

□ (Н еобязательно) Д ож дитесь начала автом атической  записи  
и  п ерей дите к эт. 7.

5. Н аж м и те  кнопку Enable Gating (Разреш ить синхронизацию ).

6 . Ч тобы  избеж ать запуска сканирования в течение интервала 
си н хрони зац и и , дож дитесь, когда ды хательное д ви ж ени е 
окаж ется за гран и ц ей  выхода из и нтервала си н хрони зац и и , 
и  н аж м и те кнопку Start (Пуск) сканера.

7. Р азр еш и те п ро до л ж и ть  запись и сканирование согласно 
сущ ествую щ ем у в учр еж д ен и и  п ротоколу  и л и  и нструкц иям  
д ля  данного пациента.

Использование методики задержки дыхания во время 
получения синхронизированных изображений и данных
о дыхании

1 . Щ елкните Track (Отследить) на пан ели  инструм ентов RPM.

2. Б ответ на п р и гл аш ен и е сохранить данны е д ви ж ен и я для  
нового сеанса вы берите No (Нет), чтобы  не сохранять 
и зм ен ен и я порогов.

3. П о д ости ж ен и и  п ац иентом  норм ального, п ериодического  
тем п а ды хания н аж м и те на пан ели  задач кнопку Record 
(Запись) и  отслеж ивайте сигнал ды хания на диаграм м е,

4. П о ан алоги и  с п робн ой  п ро ц еду р о й  п оп роси те  п ац и ен та  по 
возм ож ности  следить за данны м и на видеом ониторе, чтобы 
ц елен ап равлен но  достичь указанного уровня задерж ки  
ды хания и  п оддерж ивать  его.

В изуальной  подсказкой  для п ациента служ и т ж елтая  и ли  
зеленая полоса, вы ходящ ая из области  тем но-синего цвета 
и  возвращ аю щ аяся в нее.
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5. С ледите за ды ханием  и в следую щ ий п одход ящ и й  м ом ент 
п оп роси те  п ац иента выдохнуть, глубоко вдохнуть и задерж ать 
дыхание, как это делалось ранее.

К ривая диаграм м ы  п ерем ещ ается в интервал  си н хрони зац и и , 
а п одви ж н ая л и н и я  — в область тем но-синего цвета.

6 . В ы полните указанны е н и ж е действия, чтобы  получить 
скан ирован и я в соответствии с ти п ом  ды хания пациента.

□ Запустите К Т-сканирование вручную , как только  реш ите, 
что задерж ка ды хания п ац иентом  достаточно стабильна.

□ С ледя за записью  зад ерж ки  ды хания на диаграм м е, 
дож дитесь  окончания КТ- и ли  П Э Т -сканирования
и попросите пациента расслабиться и дыш ать в нормальном 
тем пе.

□ Если во время сканирования пациент выдохнет, то остановите 
сканирование.

□ Если необходимо остановить сканирование в произвольны й 
момент, н аж м и те  кнопку S top  (О становить) на панели  
инструм ентов RPM  и л и  S top  G a tin g  (О становить 
синхронизацию ). Д ополн ительн ы е сведения см. в разделе 
«Остановка синхронизации»  на стр. 214.

7. П овторяй те эт. 6 , пока не будет получено необходим ое число 
сканированны х и зображ ен и й .

8 . Н аж м и те  кнопку S top (Остановить). Р еж и м  получения 
и зо б р аж ен и й  см енится р еж и м о м  план ирован и я.

9. П росм отри те запись, и нструкц ии  см. в разделе «П росм отр 
записанны х данных си м уляц и и»  на стр. 205,
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Приостановка сканирования в течение интервала 
синхронизации

Ф

Э тот подход позволяет приостановить интервал  си н хрони зац и и  
без остановки сканирования.

Работа системы  м ож ет быть заверш ена из-за п ревы ш ен ия 
врем ени  ож и дан ия , если  н аруш и лся регулярны й  характер  
ды хания в КТ- и л и  П ЭТ-системе, ли б о  если  см естился блок 
м аркеров  на пациенте. О становки сканирования внутри 
интервала си н хрони зац и и  м ож но избеж ать.

1. Н аж м и те  кнопку Stop (Остановить) на п ан ели  инструментов, 
чтобы  остановить запись, затем  п роверьте п о ло ж ен и е 
п ац и ен та  и блока маркеров.

2. П осле п р о вер ки  п ац иента н аж м и те  кнопку Track (Отследить), 
чтобы  снова начать сеанс терапи и .

3. Б диалоговом  окне, в котором  предлагается сохранить только 
что записанны е данны е движ ения, н аж м ите кнопку No (Нет).

4. В озобновите запись и  процесс син хрони зи рован ной  терапи и .

Остановка синхронизации
М ож ет потребоваться остановка автом атически зап ущ енн ой  
последовательности  синхрони зи рован ной  К Т -визуализации . 
С и н хрон и зац и ю  м ож но  остановить, чтобы  нем едленно 
приостан ови ть последую щ ие КТ-срезы.

В ы берите один  и з вариантов.
□ Н аж м и те  кнопку Stop (О становить) на п ан ели  

инструм ентов Gating (С инхронизация).

ВНИМАНИЕ! При нажатии кнопки Stop (Остановить) на панели 
инструментов ретроспективное рентгеновское излучение КТ или 
сбор данных не останавливаются. Если КТ-сканирование остановить 
не удастся, пациент может получить чрезмерную дозу 
диагностического рентгеновского излучения.

□ Щ елкните Stop Gating (Остановить синхронизацию ), чтобы 
остановить синхронизацию , но п родолж ить запись данных.

□ И спользуйте обычную процедуру отклю чения сканирования 
для и сп ользуем ой  КТ-системы.

214 Проведение терапии Инструкции по эксплуатации
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ф

Экспорт данных синхронизации по дыханию

1. В ы берите File > Export (Ф айл > Экспорт).

2 . Б диалоговом  окне File E xport (Э кспорт ф айлов) введите 
зап раш и ваем ы е данные, н ап р и м ер  н ом ер обследования 
и  серий н ы й  номер.

3. (Н еобязательно) Ч тобы  просм отреть  расчеты  пиков, 
вы полните описанны е н иж е действия.
a. Щ елкните Review (А нализ), чтобы  откры ть диалоговое 

окно Phase R ecalculation R eview  (А нализ повторного  
расчета фазы).

b . П р о ан али зи р у й те  повторны е расчеты  пиков.
c. П р и  необходим ости  добавьте и ли  удалите п и ки . В случае 

внесения и зм ен ен и й  н аж м и те кнопку Save Changes 
(С охранить изм енения), а затем  — Exit (Выход).

4. Н аж м и те  кнопку ОК, чтобы  закры ть диалоговое окно 
File E xport (Э кспорт ф айлов).

5. Щ елкните Close Patient (Закры ть п ац иента) на п ан ел и  сеанса.

Глава 7 Синхронизация по дыханию 215
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